
  

Worksheets for real 
handwriting practice

Digital handwriting games  
with a choice of fonts

Pupil log-in for 
school and home

Lesson Planners for 
printed and cursive 

handwriting

MANUAL
Handwriting

Letter-join is an on-line, whole school 
scheme that includes everything you 

need to teach handwriting.  

Display Printed or Cursive  
handwriting fonts to suit 
your handwriting style 



Letter-join is a whole school handwriting scheme offering 
teachers the option to start teaching handwriting using 

either printed or cursive letters. 

The Letter-join website is continuously updated with new 

resources providing the most comprehensive and enjoyable 

handwriting scheme for teachers and pupils. If you are new 

to Letter-join, register for a free trial at www.letterjoin.co.uk
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Letter-join in the classroom 
Letter-join is an online handwriting resource for 
teaching handwriting on interactive whiteboards. It 
includes animations, touch-screen activities, cursive 
and printed fonts, lesson planners and access to 
hundreds of practice worksheets.

Choice of Letter-join fonts 
Class teachers can choose Cursive or Printed fonts 
to use for online resources and printouts. School 
subscribers can download fonts to use in MS Word.

Alternative letterforms 
Letter-join cursive fonts include alternative 
letterforms for f, k, w, x and z. The printed font has 
alternative letterforms for f and k. 

Letter-join practice worksheets  
Letter-join contains worksheets and printouts in PDF 
format. These will use your class choice of font and 
your school’s preferred letterforms.

Letter-join on iPads and tablets 
Letter-join access on iPads and tablets is included 
with school subscriptions. Letter-join’s fun, touch-
screen activities are compatible with most Apple, 
Android and Windows tablets.

Free home access for your children 
Letter-join includes free access for pupils to log in to 
Letter-join at home on PCs and tablets. 

Handwriting Lesson Planners 
For schools wishing to follow a structured 
handwriting plan, there are handwriting Lesson 
Planners for all year groups. There is also a 
Handwriting Assessment Tracker and Handwriting 
Recovery Programme.

Handwriting Policy Document 
Letter-join includes a curriculum-based Handwriting 
Policy that can be personalised by schools.

Essential Letter-join

Font choices are auto selected 
for pupils in class and at home.

Letterforms and fonts to suit your handwriting policy

Lesson Planners for cursive or printed letters

Teachers can select different 
Letter-join fonts for activities and 

worksheets.

Choose and print worksheets in your chosen  
font for real handwriting practice.

SET A TASK

Teach handwriting
Cursive       Printedor

Welcome to Letter-join

Recently added to Letter-join: a new printed font, 
Print Plus, and linked resources for Early Years 
and Key Stage 1.

40  The School Administrator page	
How to personalise Letter-join for 
your school.

42  Letter-join for pupils at home 
Access Letter-join at home.

43  Installing fonts 
Downloading and installing  
Letter-join fonts on PCs and  
across networks.

43	 LearnPad installation 
Access Letter-join on a Learn Pad.

Classroom set-up for teachers
4  Classroom set-up

5  The Letter-join menu

6  The 7 Letter-join fonts 
 

7   Font set-up for MS Word

38  School Administrator page

School Admin & Tech

Apple Safari

Google Chrome

RECOMMENDED 
BROWSERS

EYFS Lesson Planner 
MODULE 1

Print and Cursive

KS1 Lesson Planner 
MODULES 2 & 3
Print and Cursive

14	 Resources to teach 
other character sets 
and to reinforce and 
practise handwriting.  

Lesson  
Planners

8	 Designed for schools wishing to 
follow a whole school approach to  
handwriting.

KS2 Lesson Planner
MODULES 4 to 7

Cursive

20	 Exercises to promote fluent 
and legible handwriting 
to help reach National 
Curriculum expectations.

24   Introduction

26   Printout sheets

29   Worksheet Generator

 

30  Dictation Exercises

32  On-line Word Processor

34  Word Animator and Word Banks

Resources

Contents

10	 Structured programme 
to introduce handwriting 
to Early Years pupils. 



Watch animations with 
spoken word instructions

Touch-screen activities for 
IWBs, iPads and tablets

Choose a letter to watch (font choices 
available under Classroom Font options)

Practice worksheets accompany 
all sections
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Letter-join workflow: animation to worksheet
Animations for individual letters include voiced instructions 
and link to an accompanying practice worksheet.

The Letter-join menu  

CLASSROOM SET-UP
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Click on the Info button on any Letter-join web 
page for essential classroom information.

Teachers’ 
Information Panel

Letter-join  
VIDEOS

CHANGE YOUR 
CLASSROOM 
FONT HERE! 

Essential videos and 
presentations to help 
get the most from 
Letter-join.

How to get your 
pupils using 
Letter-join at home.

Change Class Name 
and Year Group of 
your Classroom 
account.

Instruction  
Guides
l	 Handwriting Lesson Planners 

(PDF format)

l	 Handwriting Manual for 
teachers

l	 Handwriting Policy

l	 Font guide 

l	 Fonts in MS Word

l	 On-line Word Processor

l	 Setting up tablets

l	 Word Animator guide

l	 Worksheet Generator

l	 Instructions for pupils at 
home

l	 Handwriting Manuals for 
pupils and parents

l	 Left-handed Guidance

l	 Handwriting Progression

l	 Handwriting Recovery

Classroom Set-up
Search to find any  
Letter-join worksheet

Search here to find any
Letter-join worksheet



Individual class fonts 
Class teachers can use any Letter-join font for their 
class by clicking the ‘Info’ button and choosing 
‘Classroom Font Options’. The chosen font will be 
used for all Letter-join activities.

Letter-join fonts for MS Word 
Letter-join fonts can be downloaded by school  
subscribers from the Admin page for use in MS Word.  
See ‘Installing fonts’ page 43. 

Letter-join fonts: use without a download 
The Letter-join on-line Word Processor is designed to 
produce documents using Letter-join fonts, without 
needing to download to a computer. Find out more on 
page 32.

Watch Letter-join Font Videos 
letterjoin.co.uk/videos.html

Please make sure that the Letter-join fonts are 
installed - see page 43.

With the Letter-join fonts installed on your 
computer open MS Word and check that the 
fonts are displayed in the font list. 

If the Letter-join fonts are not listed, re-start 
MS Word.

How to switch on Contextual Alternates: 
• Highlight all text. 
• Select Format > Font (or Ctrl D). 
• Select the ‘Advanced’ tab. 
• Tick the ‘Use Contextual Alternates’ button.

This option has to be selected every time MS 
Word is re-opened or alternatively a Word 
template can be created with Contextual 
Alternates already enabled.

Switching on Contextual Alternates in Microsoft Word
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CONTEXTUAL ALTERNATES SWITCHED OFF

apple

Create a Word Template to keep 
Letter-join’s font preferences 
You can create a time-saving template to use that has 
the Letter-join font selected with contextual alternates 
enabled.

Open a new Word document and select Ctrl + D. 
Choose the Letter-Join font. Select the Advanced tab 
and enable ‘Use Contextual Alternates’ then click OK.

Navigate to File > Save as. In the ‘Save as type’ field 
change from the default ‘Word Document (*.docx)’ to 
‘Word Template (*.dotx)’ and name the file.

LETTER-JOIN FONTS IN MICROSOFT WORD

 

Distribute this file to all staff who will use the Letter-
join fonts in MS Word. When the template file is 
opened both the correct font and the ‘Use Contextual 
Alternates’ option are automatically enabled.

Word Template

• Select text.

• In MS Word, select Format > Font (or Ctrl D).

• Select the ‘Advanced’ tab.

• Tick the ‘Use Contextual Alternates’ button. 

This option has to be selected every time MS Word is re-opened 
or alternatively a Word template can be created with Contextual 
Alternates already selected, as shown on the right.

Contextual Alternates

When using any of the Letter-join fonts in MS Word 

it is important to select the Contextual Alternates 

option to correctly reproduce the cursive letterforms 

and use the correct joining strokes.

How to switch on Contextual Alternates
With the Letter-join fonts installed on your computer the Letter-
join fonts will be displayed in the MS Word font list. If they are 
not showing, re-start MS Word for the fonts to show.

✔

CONTEXTUAL ALTERNATES SWITCHED OFF 

Lead-in lines and joins are formed correctly

✘
Lead-in lines are missing and joins are incorrectly formed

CONTEXTUAL ALTERNATES SWITCHED ON

Lead-in line 
missing

Wrongly shaped 
letters that overlap

Display cursive fonts correctly in MS Word 

When using any of the Letter-join cursive fonts in 
Microsoft Word it is important to switch on the Contextual 
Alternates option to correctly reproduce the cursive 
letterforms and use the correct joining strokes between 
letters. Please set-up as shown below. 

About Contextual Alternates 
Contextual Alternatives is a typographical term for 
correctly joining cursive letters together.

Letter-join font software compatibility 
As well as MS Word, Contextual Alternates is 
auto-selected by Apple Pages. For programmes that do 
not have Contextual Alternates, please use the Letter-join 
Basic font as shown on opposite page.

CONTEXTUAL ALTERNATES SWITCHED ON

apple

Create a Word Template to keep 
Letter-join’s font preferences 
You can create a time-saving template to use that has 
the Letter-join font selected with contextual alternates 
enabled.

Open a new Word document and select Ctrl + D. 
Choose the Letter-Join font. Select the Advanced tab 
and enable ‘Use Contextual Alternates’ then click OK.

Navigate to File > Save as. In the ‘Save as type’ field 
change from the default ‘Word Document (*.docx)’ to 
‘Word Template (*.dotx)’ and name the file.

LETTER-JOIN FONTS IN MICROSOFT WORD

 

Distribute this file to all staff who will use the Letter-
join fonts in MS Word. When the template file is 
opened both the correct font and the ‘Use Contextual 
Alternates’ option are automatically enabled.

Word Template

• Select text.

• In MS Word, select Format > Font (or Ctrl D).

• Select the ‘Advanced’ tab.

• Tick the ‘Use Contextual Alternates’ button. 

This option has to be selected every time MS Word is re-opened 
or alternatively a Word template can be created with Contextual 
Alternates already selected, as shown on the right.

Contextual Alternates

When using any of the Letter-join fonts in MS Word 

it is important to select the Contextual Alternates 

option to correctly reproduce the cursive letterforms 

and use the correct joining strokes.

How to switch on Contextual Alternates
With the Letter-join fonts installed on your computer the Letter-
join fonts will be displayed in the MS Word font list. If they are 
not showing, re-start MS Word for the fonts to show.

✔

CONTEXTUAL ALTERNATES SWITCHED OFF 

Lead-in lines and joins are formed correctly

✘
Lead-in lines are missing and joins are incorrectly formed

CONTEXTUAL ALTERNATES SWITCHED ON

CLASSROOM SET-UP

Letter-join cursive and printed fonts 
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CLASSROOM SET-UP

the dog ran

the dog ran

the dog ran

the dog ran

the dog ran

the dog ran 

Letter-join Air Plus

Letter-join Air Plus is used when wanting to teach 
continuous cursive letters that are not joined.

Letter-join Air No-lead

Letter-join Air No-lead does not include a lead-in line 
and the letters are not joined.

Letter-join Print

Letter-join Basic

Letter-join Print matches the letter style used in 
Letter-join to teach printed letters.  

Letter-join Basic is designed for use with PowerPoint 
and Smart Notebook. It is based on Letter-join Plus.

the dog ranLetter-join No-lead

Letter-join No-lead has no lead-in line but has a 
lead-out line that joins to the following letter.

Letter-join Plus

Letter-join Plus is a continuous cursive font  
with lead-in and lead-out lines.

Letter-join Print Plus

Letter-join Print Plus has simple exit strokes for letters 
that end ‘on the line’. 
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Handwriting Lesson Planners
The seven Letter-join Lesson Planners provide structured 
lessons for teaching printed and cursive handwriting. Handwriting worksheets 

Letter-join Handwriting Lesson plans 
progress through a series of worksheets 
combining handwriting practice with SATs 
revision topics for KS1 and KS2. 

Lesson Planners cover each of the key 
stage requirements and are written by 
teachers and editors with expertise in 
EYFS, KS1 and KS2. 

They are developed in keeping with the 
UK National Curriculum and use 
Letter-join’s resources to provide a 
thorough and interesting way to teach 
handwriting.

How to download Lesson Planners 
Letter-join Lesson Planners and their 
corresponding worksheets links can be 
accessed from the ‘Lesson Planners’ 
option on the Teachers Info page.

Handwriting Recovery Programme 
Designed for pupils in upper Key Stage 2 
and above who require extra support with 
their handwriting.

Handwriting Assessment Tracker 
Provides a complete scheme to assess 
pupils’ progression in handwriting skills 
from Early Years to Year 6.

KS1 and KS2 handwriting practice includes SPaG 
topics and longer passages of text.

Early Years lessons cover all lowercase letters; 
either printed or cursive fonts.
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LESSON PLANNERS

YEAR 5
MODULE 6 

60 LESSONS

Combine fluent handwriting 
with other curriculum 

subjects.

CURSIVE

YEAR 6
MODULE 7 

60 LESSONS

Develop more of a personal 
handwriting style and write 

with automaticity.

CURSIVE

To suit your school’s handwriting policy, Letter-join’s Lesson Planners offer two routes into teaching 
handwriting; either printed or cursive letters in Early Years and Key Stage 1.

EARLY YEARS 
MODULE 1 PRINT  

70 LESSONS

Starting handwriting with 
printed letters.

PRINTED

YEAR 1
MODULE 2 Print to Cursive

80 LESSONS 

Handwriting with printed 
letters and preparing for 

cursive writing.

PRINTED

YEAR 2
MODULE 3 PRINT 

90 LESSONS

Starting cursive handwriting 
and increasing fluency 

and speed.

PRINTED

EARLY YEARS 
MODULE 1 CURSIVE  

70 LESSONS

Starting cursive 
handwriting in Early Years.

CURSIVE

YEAR 3
MODULE 4 

60 LESSONS

Improve legibility,  
consistency and quality  

of handwriting.

CURSIVE

YEAR 4
MODULE 5 

60 LESSONS 

Apply size-appropriate 
handwriting to all areas of 

the curriculum.

CURSIVE

YEAR 1
MODULE 2 CURSIVE 

80 LESSONS 

Capital letters, printed 
letters, numbers, 

punctuation and symbols.

CURSIVE

YEAR 2
MODULE 3 CURSIVE 

90 LESSONS

Increase fluency and speed 
of handwriting through 

regular practice.

CURSIVE

Each module has links to corresponding 
worksheets.

Lesson Planners are provided in PDF format and can be downloaded from the teachers’ ‘Info’ page.

Both can be downloaded from the  
Letter-join Lesson Planners page.

Lesson Planners: Early Years through to Year 6



Letter-join offers the option to start teaching 
handwriting using printed letters, for all 
resources and worksheets, before moving on 
to cursive handwriting. 

Patterns and pre-writing shapes can be 
challenging for young pupils, but Letter-join 
has all the resources needed to introduce the 
different handwriting strokes.

Letter-join’s animations present pre-writing 
patterns with fun sounds that can be copied 
by air-writing or by tracing on IWBs, tablets 
and, most importantly, by practising with a 
pencil on printed worksheets. 

This naturally leads on to the introduction of 
real letters. Watching and copying the shapes 
of letters and the various joining techniques, 
if appropriate, will enable pupils to learn to 
write simple words at this early stage.

Early Years 
Foundation 
Stage

10  LETTER-JOIN HANDWRITING MANUAL

Lesson Planner

To complement Letter-join worksheets for patterns, 
letters and words, children can choose Letter-join’s 
touch-screen activities to enhance writing skills. 
Use any Letter-join printed or cursive font to display 
in activities.  

Choose the font that’s most appropriate  
for your class. 

EYFS touch-screen activities  

PhonicsMatch 
Combine handwriting and phonics 
with Letter-join’s fun, interactive 
phonics resources. 

Letter Families 
Reinforce the different letter 
shapes and show children the 
correct way to write the letters. 

Magic Patterns 
A selection of patterns, shapes and 
mazes for tracing.

Magic Words
Enter any word to trace on a variety 
of colourful backgrounds.

LetterMatch
LetterMatch is an activity to teach 
children the names and sounds of 
the letters of the alphabet. 

When the sounds have been learned, 
play a matching pairs game to 
reinforce the learning task. 

Ideal for children to use at home on 
iPads and PCs for independent 
learning. Find LetterMatch under the 
‘Fun’ tab.
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LetterMatch 
Helps teach the names and 
sounds of the letters of the 
alphabet.

MODULE 1 FOR PRINTED 
OR CURSIVE LETTERS

EYFS



Letters and words made simple
Watch, practise, trace and copy –  
the easy way to learn handwriting.
Letter-join introduces animations of the 
letters of the alphabet in a progressive 
manner starting with ‘long ladder letters’ 
and building up to the more complex 
letter shapes. 

Each letter is presented as an animation 
with a spoken description.

There are also opportunities to ‘try’ letters 
and words on IWBs and tablets. 

Each set of letters is followed by 
accompanying words illustrating the 
joining methods of the letters  
just practised. 

The letter and word sets can be  
printed in three different sizes for real  
handwriting practice. 

Each set of words also includes a 
worksheet which models each of 
the words in a sentence helping 
children to understand the word  
in context.
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EYFS

WITHOUT LEAD-IN LINE OPTION

To change a Letter-join font, click the ‘Info’ 
button on any Letter-join page and choose  
‘Classroom Font Options’.

Animations of letters and words and 
associated worksheets are available 
without lead-in lines. 

Use Letter-join’s Word Animator to create 
an animation of any word.

These can be saved into Word Banks for 
children to use at home.

WORD ANIMATOR 
Create animations  

for any word

CLASSROOM FONT OPTIONS

Interactive whiteboard display allows for whole class involvement.

Letter-join provides a selection of fun 
pre-writing patterns for EYFS pupils that 
cover all handwriting movements. These 
encourage fine and gross motor skills as 
a foundation to handwriting. 

Presented at a large scale the IWB, 
Letter-join is perfect for practising gross 
motor skills by air-writing the shapes. 
Finer control can be gained by finger 
writing on tablets or with a pencil using 
the worksheets. Worksheets consist of 
lines of patterns for tracing using a pencil 
or crayon and a simple drawing which 
can be ‘coloured-in’ using the patterns of 
that group.

Pre-writing patterns cover all writing shapes.

Develop writing skills with pre-writing patterns 
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EYFS

Word Banks can be easily made into spelling 
lists and word searches can be accessed by 
children who log-in to Letter-join at home.

WORD BANKS
Make class word banks

Start handwriting using
printed or cursive letters 
Letter-join has now expanded to include 
a new Print font and Lesson Planners 
giving teachers the choice to start 
teaching handwriting using printed or 
cursive letters.

Watch patterns, such as jellies, with fun sounds.

Fun worksheets are available as PDFs 
for all the pattern sets for handwriting 
practice using pencils and crayons.



Key Stage 1
Handwriting can be fun and Letter-join 
will help reinforce skills throughout  
KS1 with a mix of touch-screen and 
traditional activities.

KS1 is the time to introduce new 
letterforms including capital letters, 
numbers and punctuation. To show the 
correct letter construction, Letter-join 
includes animations for all of these, and 
provides ready-made worksheets for 
labelling and form-filling using capital and 
printed letters.

Key Stage 1 children should be working to 
produce neater handwriting with consistent 
spacing. Handwriting speed can be 
improved and developed using Letter-join’s 
dictation exercises.

Teachers can set home learning tasks for 
their class, and pupils can log into 
Letter-join at home, on iPads and tablets, 
to access the tasks and use Letter-join’s 
other fun activities.  
See page 42 for details.
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Letter-join offers a series of 
worksheets to support KS1 SATS 
which are not only great for 
improving handwriting, but are 
also perfect for the revision of 
spelling, punctuation and 
grammar.  
 
There are many fun worksheets 
aimed at boosting your children’s 
confidence so they are SATs ready.

SATs worksheets can be 
downloaded from Resources > 
Printouts > Key Stage 1 and are 
also used in Handwriting Lesson 
Planner, Module 3.

KS1 SPaG Revision
Lets try...

MODULES 2 & 3
Lesson Planner
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KEY STAGE 1

Developing pupils’ handwriting skills Reach Key Stage 1 
handwriting 
standards
•	 Demonstrate the correct methods 

for writing upper and lower case 
letters with the correct joins.

•	 Show how to form numerals of 
the same size that sit on the 
base line.

•	 Teach how to write printed letters 
and use Letter-join’s animations 
and worksheets to practise how 
they are used.

•	 Ensure that pupils know how 
much space to leave between 
words.

•	 Encourage pupils to write longer 
passages of text to build up 
endurance using the Dictation 
Exercises.

•	 Use Letter-join’s worksheets to 
ensure that letters sit on the 
base line and are consistent in 
size with correctly formed 
ascenders and descenders.

KEY STAGE 1

Letter-join worksheets in 
‘Resources’

Capital letters, printed letters, numbers 
and symbols can be practised using real 
handwriting on the many worksheets 
provided in ‘Resources’.

For the complete listing of printout 
sheets, Letter-join users can visit 
Resources > Printouts. See page 24.

Practise number writing

Letter-join includes a full set of times 
tables worksheets, up to 12 x 12, which 
are great for practising number writing. 
They are provided in look, trace and copy 
format.

Magic Words, in the ‘Fun’ section, can also 
be used to practise number writing.

Introduce form-filling 

Pupils can learn how to write within the 
constraints of a form using printed and 
capital letters. Letter-join includes a 
selection of forms for Key Stages 1 and 2.

For capitals, numbers and printed letters, try ‘More Letters’ for 
touch-screen activities and worksheets.

Numbers and symbols

Touch-screen activities can be 
used for immediate practice of 
numbers and symbols. For real 
handwriting practice there is 
varied and interesting selection 
of worksheets.
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Capital letters

Letter-join’s animations teach 
how to form capital letters 
correctly. To accompany 
teaching, there are Letter-join 
worksheets specifically for 
practising capital letters e.g. 
writing names, form-filling, 
crosswords and word searches.

Printed letters

KS1 activities for practising 
printed letters include labelling 
diagrams, writing email addresses 
and worksheets that include a 
mixture of printed and capital 
letters, for instance when  
addressing an envelope.



KEY STAGE 1

Magic Words is a great way for KS1 pupils 
to type in their own words and practise 
their handwriting using the touch-screen 
capabilities of iPads and tablets. Class 
teachers are able to select the Letter-join 

font they wish their pupils to practise 
with. There are five exciting, colourful 
backgrounds and a simple star reward 
function, which pupils will enjoy using on 
their tablets at school and at home.  

Letter-join’s Dictation Exercises are a great 
way to introduce speedy writing and help 
build up stamina. 

 

Dictation Exercises help with children’s 
listening skills and in learning how to 
revise and edit their writing. 

The dictation exercises for KS1 start with a 
simple spelling list, a list of 2-digit 
numbers and an easy poem.

Practise speedy writing with Dictation Exercises

Letter-join’s Magic Words – touch-screen activities

A dictation list written out as a first draft and a final copy.  
See page 30 for more information about Dictation Exercises.
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KEY STAGE 1

Try Letter Families worksheets  
and touch-screen activity 
Help pupils become familiar with similar letter shapes and 
become confident at writing differently formed characters.

Spelling worksheets include all 
the long vowel sounds

Sequencing sentences with 
guidelines for handwriting practice

Prepositions presented with 
colourful graphics

Handwriting worksheets 

Handwriting and spelling go together and Letter-join provides 
many spelling worksheets for practising handwriting. 

These include: pangrams, high frequency words, cloze sentences, 
word spacing and joining techniques. See pages 26 to 28 for 
more worksheet examples. 

SPaG practice worksheets
A series of worksheets which specifically cover spelling, 
punctuation and grammar practice. As well as providing excellent 
revision and homework sheets, the printouts also provide plenty 
of handwriting practice. KS1 worksheets are available with 
printed or cursive fonts.
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Using the familiar format of long ladders, curly caterpillars, 
one-armed robots and zig-zag letters, Letter-join’s Letter Families 
worksheets can be printed out for tracing and copying.

To strengthen letter formation and to learn which letters belong 
to each family, try the Letter Families touch-screen activity, under 
the ‘Fun’ tab.
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Practise topic spellings using 
the Word Animator and the 
On-line Word Processor

Let’s try...

Build animations of words for whiteboard and tablet 
practice and send to the Letter-join Word Processor 
to create ‘look, trace and copy’ spelling lists.

Build a bank of animated topic 
words for pupils to re-play and 
trace using the Word Animator.

1

Share classroom Word Banks 
with pupils to watch and 
practise.

2

Choose to make a spelling 
list or word search to extend 
Word Bank activities.

3

See page 32 
for details of 
the On-line 
Word Processor 
and page 34 
for details of 
the Word 
Animator.
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Ready for the final round of handwriting 
challenges? When pupils master these they’ll 
be true handwriting champions! 

Building on KS1 skills, pupils will be writing 
passages of text neatly and speedily, labelling 
diagrams using printed letters appropriately 
and filling in forms using legible writing. 

Letter-join’s KS2 teaching resources will help 
pupils acquire a feel for neatness and quality 
in their final handwritten work. Audio dictation 
lessons (see page 22) will develop handwriting 
stamina when writing. 

Log in to Letter-join as a Key Stage 2 class 
(see ‘Classroom Options’ on page 4) and 
Letter-join will display a page of links to a 
range of resources specifically for KS2. This 
includes quick links to Lesson Planner 
worksheets and the Handwriting Recovery 
programme, and direct links to categorised KS2 
worksheets and resources.

With the support of Letter-join, pupils will 
have covered all the criteria necessary by the 
end of Year 6 to reach the standards set out 
in the National Curriculum for handwriting.

Key Stage 2

Lesson Planner

MODULES 4 to 7

KEY STAGE 2

KS2 home page with quick links to a range of resources.



KEY STAGE 2
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The National Curriculum 
tasks Key Stage 2 pupils 
with aiming for quality, 
speed and stamina.
Letter-join’s resources will help 
to attain this target and provides 
worksheets and exercises to help 
improve handwriting.

The National Curriculum criteria for 
KS2 handwriting includes:

Introducing Letter-join’s advanced handwriting exercises 
to reach KS2 National Curriculum standards.

Write in Time!
A handwriting activity for Key Stage 2 
children that provides the opportunity 
to practise fast and fluent handwriting 
which is neat and legible. To play the 
game, children choose from eight 
familiar KS2 topics. The more words 
that are neatly written, the higher the 
award given.

Accomplishing neat handwriting

Curriculum topics

Letter-join provides opportunities to link handwriting practice to other areas of the 
curriculum and combines handwriting practice with other KS2 tasks such as statutory 
word lists.
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KEY STAGE 2

Challenging dictation  
exercises for KS2
These exercises will help with stamina, 
speedy note-taking and encourage 
proof-checking and editing.

Quality: 
Ensure that letters are of consistent 
size with equal word spacing and 
that ascenders and descenders  
are parallel and do not interfere 
with the writing on the above or 
below lines.

Speed:  
Improve speed of handwriting 
to allow creative writing to take 
precedence over the task of 
handwriting and be able to take 
‘quick notes’ at a faster pace. 
 
Stamina:  
Have the strength and mobility to 
be able to write for longer periods 
of time without fatigue.

Pupils are expected to have full 
knowledge of different kinds of 
handwriting for different purposes 
including:

• Neat, joined, cursive letters for 
writing passages, large amounts of 
text, lists and letters.

• Printed or capital letters for 
posters, presentations, headings, 
labelling and form filling.

• Speedy handwriting for note-
taking and dictation where  
neatness is not as important and 
shortcuts can be used, such as ‘+’ 
instead of ‘and’.

Extract from  
Hansel and Gretel

...it was built of 
bread and covered 
with cakes...



		

		

Dictation Exercises

On-line Word Processor

Improve listening skills as well as 
handwriting speed, accuracy, 
note-taking and editing.

Key Stage 1
•	A selection of CVC words, a list of numbers and 

an easy poem.

•	Harder dictation exercises: a list of phrases, 
easy additions and a three-verse poem.

•	Sentences and paragraphs using years 1 and 2 
common exception and high frequency words.

Key Stage 2
•	More challenging exercises: a shopping list, 

complex numbers and a longer written passage.

•	Dictation exercises using extracts from 
traditional stories and poems.

Create and save documents using any 
of the Letter-join fonts. 
An on-line alternative to MS Word for creating 
spelling lists, classroom presentations and 
much, much more! The on-line Word Processor 
does not require Letter-join fonts to be 
downloaded onto computers. 
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RESOURCES

		

Worksheet Generator
Create handwriting worksheets for spelling 
lists, sentence sheets and posters. 
Choose any of the Letter-join fonts to produce 
worksheets. Worksheets are created within internet 
browsers and your school’s choices of preferred 
letterforms will be used. They can be saved as 
PDFs for future use.

Page 29Page 30

		

Warm-up Exercises
Develop gross and fine motor skills. 
Pupils will enjoy Letter-join’s fun warm-up 
exercises for gross and fine motor skills.  
They can be found in the Letter-join Lesson 
Planners and on-line under Resources.

Find on-line in ResourcesPage 32

BUILD A  
WORD BANK

3
PRACTICE  
FOR PUPILS

4
CREATE
ANIMATION

2
TYPE A WORD

1
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Word Animator
Create animations of words to save into classroom Word Banks.

Printout Sheets 

Letter-join includes hundreds of worksheets divided into five 
sections which can be printed with your choice of font and use 
a school’s chosen alternative letterforms.

Page 34

• Printout sheets

• Word Animator

• On-line Word Processor

• Dictation Exercises

• Warm-up Exercises

• Worksheet Generator

Pages 
26 to 28

Resources
Letter-join resources include hundreds of printouts, 
and tools to help you create your own content. Create 
spelling lists, word banks and posters, all of which 
can be saved and shared for future use.



Worksheets to consolidate correct letter formation using 
sentences that contain all the letters of the alphabet. 

Word lists 
 

MFL worksheets 

SPaG worksheets 
A growing series of worksheets combining handwriting practice with KS1 and KS2 SATs revision.

Missing words sentences using words 
from the word lists for Years 3-4 and 
Years 5-6.

Spelling lists and sentences 
Punctuation practice in the context of 
meaningful sentences. Worksheets cover 
all the punctuation requirements.

A series of exercises covering the grammar 
topics required for KS1 and KS2 SATs such 
as adjectives and prepositions.

Practise spelling rules and patterns with 
trace and copy word lists then reinforce 
with complementary ‘missing words’ 
worksheets.

Punctuation Grammar

Cloze exercises

Worksheets combining handwriting practice 
and French/Spanish vocabulary. 

Spelling words, as listed in the DfE’s English 
Programmes of Study in look, trace and 
copy format.

Pangrams
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RESOURCES

High frequency words 
100 high frequency words to trace 
and copy for EYFS and KS1 in 
large, medium and small sizes. 

Printouts

Letter families 
Colourful worksheets to help with the different families of letter shapes. 

Sequencing sentences 
Write sentences in order to form 
short narratives. Two different 
levels for years 1-2 and years 2-3.
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Letter-join includes hundreds of printouts using 
your choice of font and alternative letterforms

All printouts are available 
in two font styles:

• WITH lead-in lines

• WITHOUT lead-in lines

Early Years and KS1 
printouts are also 
available in the print font.

Font style

Handwriting worksheet examples



Worksheet Generator

Create your own handwriting worksheets  
for spelling lists, sentence sheets and posters.
Each classroom account can choose  

any of the Letter-join fonts to produce 

printouts using the Worksheet Generator. 

Worksheets are created within internet 

browsers and your school’s choices of 

preferred letterforms for f, k, w, x and z  

will be used.

Spelling Lists Sentence Sheets Posters/Freestyle 

Worksheet  
Generator 
Hints and Tips

Changing the font 
You can quickly change the font 
via the ‘Info’ button and choose 
‘Classroom Font Options’.

The font is not joining correctly 
on the Worksheet Generator. 
Do not use Internet Explorer 
for Letter-join! The Worksheet 
Generator will produce fonts 
correctly if using Google 
Chrome, Firefox or Safari.

PRINTING WORKSHEETS

How do I save worksheets 
created using the Worksheet 
Generator? 
The Google Chrome browser 
has a facility to save pages 
as PDF files. Create your 
worksheet as normal using 
Google Chrome and select Ctrl 
P then change ‘Destination’ to 
‘Save as PDF’. 

The worksheets are printing 
very faint and the guidelines 
are not showing. 
Some laser printers can 
struggle to print from a web 
page. Save the worksheet as a 
PDF (see above) and print from 
the PDF. 

The tracing words are printing 
in black when I generate a 
worksheet. 
If using Firefox, to print the 
tracing words in grey please 
select the ‘Print Background’ 
option from Page Setup. 
Firefox: File > Page Setup > tick 
Print Background.

The lines are over-running when 
I print a generated worksheet. 
We recommend a maximum 
number of letters/words/lines 
for each character size on 
the Worksheet Generator. If 
exceeded text lines may over-
run. Try reducing the number of 
words per line.

In three sizes with options to 
show all the guidelines or the 
baseline only.

In three sizes with options to 
hide or show guidelines and 
with trace or trace and copy 
options.

In three sizes with options 
to show guidelines, baseline 
only or no lines at all, and 
to range text left or centred.

Alphabet banners 

All the letters of the alphabet, each on an A4 sheet, to print out 
for displaying in the classroom or for pupils to colour in. 
Available as cursive, capital and printed letters.

Microsoft Word templates
Designed to match a standard handwriting book style. Choose 
from four sizes.

Numbers, Capitals and Printed 
Letters worksheets

Times tables worksheets
Trace and copy worksheets for tables facts to 12 x 12. 

Labelling exercises
A selection of worksheets for practising printed letters, 
covering curriculum-based topics for all key stages. 

Form-filling exercises
A series of form-filling exercises for all key stages to help teach 
the formation of printed and capital letters.

Alphabet printouts
A4 printouts for cursive, printed and capital letters which 
will print using your school preferred letterforms for f, k, w, 
x and z. These are useful for sending home so that parents 
know which letterforms are used at school.

Highlighted writing paper
Choose from three different line widths.

RESOURCES RESOURCES

Posters and Handouts

A4  
HIGHLIGHTED 

PAPER
Choose from 3 
different line 

widths
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How to use Letter-join Dictation Exercises

A selection of CVC 
words, a list of 
numbers and an easy 
poem.

A list of phrases, an 
easy number sentence 
and a three-verse 
poem.

Years 1 and 2 
common exception 
and high frequency 
words.

A shopping list, 
complex numbers and 
a longer written 
passage.

Longer passages 
using extracts from 
traditional stories and 
poems.

A typical Key Stage 1 dictation exercise using simple sentences

PDF for teachers to display for 
checking.

The whole passage can be displayed on the whiteboard 
for children to check their work.

Children listen to the passage and 
write down what they hear.

Pupil’s written text.Dictation sound file for class to listen to.

Dictation Exercises are found under the Resources tab.

KS1 dictation exercises use common exception and high frequency 
words in sentences and paragraphs.

The first set of KS2 dictation exercises cover a mixture of numbers 
and words.

A Key Stage 2 dictation exercise, using a traditional story, with a longer passage of text

Increase the pace of children’s note-taking

Dictation Exercises to speed up handwriting

Letter-join’s dictation exercises are a 
collection of recorded texts and 
accompanying support text, especially 
written to improve listening skills and 
increase the pace of children’s note-taking.

Dictation is a very good exercise to build 
proficiency and speed in handwriting  
as well as supporting spelling and  
editing skills.

Letter-join’s fun dictation exercises for Key 
Stages 1 and 2 cover common exception, 
high frequency and statutory words. They 
are simple and fun, and can be practised 
at school as well as at home. 

The exercises start with simple CVC words 
and progress through to longer passages 
of text to help build stamina and 
automaticity in handwriting. 

RESOURCES

1 Listen  
Click ‘Play’ on the ‘Listen’ row to play the 
dictation exercise at normal speed for the 
class to hear. This is to allow pupils to 
become familiar with the dictation they are 
about to write.

2 Write 
Press ‘Play’ on the ‘Write’ row for pupils to 
listen to a slower version of the recording, 
pressing ‘Pause’ between phrases to allow 
time for pupils to write what they hear. 

Explain that if they do not hear clearly, or 
if they don’t have time to write everything, 
they can leave a blank space which can be 
filled in later at the ‘Edit’ stage.

3 Edit 
Play the Edit recording which is at normal 
speed. This will allow pupils to fill in any 
blanks they have left, or to make changes.  
You can play this more than once, if 
necessary.

4 Write out again  
Click the link to display the written text 
so that pupils can check their work before 
writing out again using their best joined-up 
handwriting.  

1

2

3   

4 

A slippery floor
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Click ‘File’ from within 
the Word Processor 
window and select 
‘Open’. 

Choose ‘Look, trace and 
copy Spellings’ from the 
‘Templates’ section.

Other templates are 
available.

1

2

3

4

7

8

5

6

Scroll over the heading to select ‘Spellings title’ and 
overwrite the heading for your spelling list.

Open the Letter-join 
On-line Word 
Processor from the 
Resources tab.

Continue until the table is complete.

Once the list has been created, select all of the text to 
change it to your preferred font.

You can print directly to your printer or you can save 
as a PDF by changing the destination of the printer to 
‘Save as PDF’.

Now place your cursor in the cell underneath ‘Trace’, 
or use the Tab key, and type your first word again. The 
‘Trace’ text will be grey.

Scroll over ‘Insert date’ and overwrite the date or select 
an option from the pull-down menu.

You can save your worksheet using ‘Save’ at the top left 
of the Word Processor.

Place your cursor in the cell underneath Look, and type your 
first word. The ‘Look’ text will be black.

Make a spelling list with the Letter-join on-line Word Processor
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Ready-to-use Letter-join templates

The Letter-join Word Processor includes a growing number of templates 
including lined and highlighted paper, Spelling List and Year 2 Common 
Exception words for classroom display. Staff can customise templates 
on-line by typing new words and choosing any Letter-join font.

The Letter-join On-line Word Processor allows you to create 
and save documents using any of the Letter-join fonts with a 
school’s pre-selected letterforms.

Use to create worksheets, posters and notices when using a 
computer that does not have the Letter-join fonts or  
MS Word installed.

How to use
Log in to your Letter-join classroom account, 
select the ‘Resources’ tab and choose ‘W 
Processor’. You can either start typing 
to create a new document using familiar 
commands, or open any of the ready-to-use 
template files to overwrite with your own text 

and images. 

Please use the ‘File’ option 
on the menu bar WITHIN the 
browser window to open, save 
and print documents. Do NOT 
use Ctrl-S or File > Save etc. on 
your computer’s menu bar.

As well as each classroom’s 
saved documents, Letter-join’s 
templates and examples can be 
opened and edited.

Documents are saved for each 
classroom account. 

When printing, ensure that ‘Print 
background images’ is selected 
to print worksheets correctly.

Opening, saving and printing documents

‘Look, trace and copy’ spelling list 
Instructions can be found under the Info button. 

Letter-join On-line Word Processor
Create instant spelling lists, and more, on-line.

 

Log in and start  
designing – no need 

to install fonts!

Letter-join  
On-line Word 

Processor  
displays cursive 
fonts correctly.

RESOURCES



RESOURCES
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Word Animator 
and Word Banks

Create animations of words to save to class Word Banks

From the ‘Activities’ tab teachers can make spelling lists or word 
searches using the Word Bank words:

•	 Automatically produce look, trace and copy spelling lists by	
selecting the ‘Make Spelling List’ option. Change the font to the 
one you prefer.

•	 Make an online word search using the Word Bank words by 	
selecting the Word Search option from the Activities tab.  
The Word Search can also be printed out.

Select ‘New Word Bank’ or 
choose an existing Word Bank 
from the pull-down menu. 

Choose ‘Add a Word’ and enter 
a word. Click ‘OK’. You must 
write over the word to be able 
to save it.

Trace over the word slowly and 
smoothly. If necessary, you can 
erase and start again.

Press ‘Save’ to add the animated 
word to the Word Bank.

•	Create unlimited Word Banks, for example, of topic words, 		
spelling lists or children’s names.

•	Ready to use Word Banks (including common exception words) 	
are pre-installed.

•	Children can access their classroom’s Word Banks at school on 
a whiteboard, or at home on tablets – see opposite page.

Using class Word Banks Word Bank activities

Choose  
Select a Word Bank from 
the pull-down list.

Select ‘Fun’  
From the Letter-join menu 
choose Fun and then 
Word Bank.

Word animations that are produced by a class teacher can be watched and practised  
at school and at home on IWBs, iPads and tablets.

For Teachers - how to create animations to share with pupils

Show Pupils how to access their classroom’s Word Banks

Log in to Letter-join 
Use the Pupil Accounts log-in on an iPad or tablet to log in, 
and select the correct classroom name. 

1

1 2 3 4

2

3

Select a word 
Select a word, either on-screen or from the pull-down menu,  
to watch and practise.

4

Teachers can create animations of project words.
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Create animations of 
words for classes to 
save and replay.

   	 ‘Try’ 
	 Choose ‘Try’ to practise writing        	
	 words on a whiteboard or tablet.

Pupils can choose to make any Word Bank 
into a spelling list or word search.

Set-up Letter-join for children to practice at home

Letter-join includes a home log-in instructions 
letter for parents. See page 42.

6

‘Watch’ 
Choose ‘Watch’ to see the word being written 
on the whiteboard or tablet. Playback can be 
Freehand or Controlled.

5

Using Word Bank Activities



36   LETTER-JOIN HANDWRITING MANUAL LETTER-JOIN HANDWRITING MANUAL   37   

Write it Right!  
A fun activity that rewards 
good handwriting!

Children choose a picture, trace over 
the word and are rewarded with stars.

Children can print their 
handwriting results or 
return to the activity to 
have another go.  
Write it Right! includes 
three levels to practice.

To start Write it Right!, enter a name 
and then neatly trace over the 
lettering.

Write it Right! selects groups of 
pictures with words (easy, medium 
and hard) for children to trace.  
The activity has accompanying sounds 
and fun animations to encourage 
children to play and practice their 
letter shapes over again.

Completed handwritten words 
are then displayed with an 
audible cheer.

Magic Patterns 
A selection of patterns, shapes and mazes
for tracing on imaginative backgrounds.

Letter Families 
Reinforces different letter shapes and shows 
the correct way to write the letters.

PhonicsMatch 
A matching pairs game to beat the clock 
using cursive or printed letters. 

Write in Time!  
A Key Stage 2 activity to practise fast and fluent handwriting.

Word Search
Create class word banks to make  
word searches or spelling lists.

SoundMatch
A matching pairs game for Early Years 
to support Letter-join Phase 1 Phonics 
activities.

LetterLotto 
Practise recognition and orientation  
of cursive or printed letters.

Phozzle
Practise phonemes and graphemes to 
reveal an exciting picture.

Magic Words
Enter any word and trace on a choice of 
colourful backgrounds.

LetterMatch 
Helps teach the names and sounds of 
the letters of the alphabet.

Write it Right! 
A fun activity that rewards neat  
handwriting.

Colourful, handwriting activities for IWBs and tablets.

Fun activities

Choose from eight KS2 topics. The more words that are neatly  
written, the higher the award given.

Classroom font options
Class teachers can choose which 
font to use for Letter-join 
activities, and the same font will 
be displayed when children log in 
home.

Fun Activities 
From the Letter-join menu find the 
‘Fun’ tab to access Letter-join 
activities.
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FUN ACTIVITIES

The phoneme or grapheme is displayed along with a picture 
of the word with the phoneme or grapheme highlighted.

Letter-join Phonics

Letter-join Phonic resources encompass Phase 1 to 5. 
Teachers can display pictures of each phoneme or 
grapheme on the whiteboard and the class can hear 
them and watch them being written. 

Children can practise tracing the phonemes and 
graphemes on whiteboards or tablets and then play 
the Phonics Match game. 

Schools can choose from any of the Letter-join fonts 
for the words which accompany the phonemes and 
graphemes.

Word Search
Letter-join’s Word Searches are designed for iPads and tablets. 
They are both fun and practical, reinforcing spellings and are 
easily printed for handwriting practice.

Word searches can be automatically made from any of Letter-join’s 
pre-installed Word Banks or from a classroom Word Bank that has been 
created by a class teacher.

A4 Word Search printouts 
using words from Phonics 
Phases 2 to 5.

Handwriting practice of the phoneme or grapheme can 
be on IWBs, iPads or tablets.

Phonics Phase 5

Combine handwriting with phonics
in an easy and seamless way.

1. Choose a class Word Bank 

Letter-join Word Searches include a variety of words from CVC 
through to some of the statutory ‘tricky’ spellings.

Make Word Searches from Word Banks

To support phonics learning even further, there is a fun 
matching pairs game where children can test their memory 
powers against the clock!

Phonics posters for  
classroom display

Phonics posters can be printed out 
for class displays using your 
preferred font and letterforms.2.	 Select ‘Make Word Search’ 

from the ‘Activities’ tab.



LETTER-JOIN HANDWRITING MANUAL   41   40   LETTER-JOIN HANDWRITING MANUAL

Left hand menu
Content here can only be 
accessed by logging in 
as School Administrator.

The Administrator can 
choose preferred 
letterforms, download 
the fonts, the 
Handwriting Policy and 
other useful information 
as shown below.

School Handwriting Policy
School subscribers to Letter-join can download an editable Microsoft 
Word document of the Letter-join Handwriting Policy.

This is where to select your 
school’s preferred letterforms for 
cursive f, k, w, x, and z and 
printed f and k.  

Your choices will be used across 
all of your classroom and home 
accounts and other Letter-join 
resources.

Account Information

ADMINISTRATOR SET-UP

How to distribute 
passwords for your pupils 
to use Letter-join at home

See page 42

Choose alternative letterforms  

Log in to Letter-join with your School 
Administrator details (sent to you by email) 
to access your school’s Administrator Page, 
shown below. 

As a first task please give your staff their 
individual usernames and passwords from 
the Classroom Teacher Accounts panel.  
 

The School Administrator Page allows you 
to change preferred letterforms for your 
school, download the Letter-join fonts and 
add class names and year groups.

Left hand 
menu
Please see 
opposite page.

Lost passwords

School Admin 
Email us from a school 
email address: 
info@letterjoin.co.uk
 
Classroom Account 
Staff requiring classroom 
log-in details should 
contact their school’s 
Letter-join Administrator.

The Letter-join fonts you 
download will use the alternative 
letterforms, chosen by your 
school. See page 6 for more 
information.

Download Letter-join fontsHome instructions

(School subscriptions only)

 Air No-lead

Print Print Plus Air Plus

No-lead

Letter-join Plus

abc

School details 
Please check all details 
are current, and update 
if necessary. 

Tablet Edition  
Tablet log-in details 
for pupils to use at 
school and at home.

Pupil Account
PC log-in details for 
children to use at 
school and at home. 

Classroom Teacher 
Accounts 
Please give your staff their 
individual usernames and 
passwords. 

We recommend that class 
names are changed to your 
real class names. This helps 
pupils easily identify their class 
when logging in to their Pupil 
Accounts. 

Change the Year Group for 
each class. Letter-join will then 
display an opening page of 
targeted resources.

Pupil log-in
See page 42 for instructions for 
pupils to log in to Letter-join.

School Administrator Page
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Access for
pupils

ADMINISTRATOR SET-UP ADMINISTRATOR SET-UP
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Home Learning Tasks 
Click the ‘Set Home Learning Tasks’ button from the 
Teacher’s ‘Info’ page to create a class task.

Home
Learning

Home Learning Packs 
There are two sets of home learning packs for each 
year group. Ideal for when children work from home. 
They can be found on the Teacher’s Info page.

Installing Letter-join fonts on PCs and across networks           

4. To download the fonts please accept the Terms and Conditions and 
click on one, or each of the font name buttons, as shown below. 

The Letter-join fonts can be downloaded by subscribing schools by 

logging in to Letter-join as a School Administrator and following 

the instructions below.

IT technicians and class teachers can also download the Letter-join 

Font Guide from the Info page for more information about 

installing and using Letter-join fonts.

Letter-join desktop log-in.

1. From the Letter-join home page, log in as 
Administrator on your desktop computer.

Font download options from the Administrator page.

‘Download fonts’ is in the left hand menu.

Choosing your school’s preferred letterforms.

Installing fonts on individual PCs

Installing fonts across networks

3. Select ‘Download fonts’ and follow instructions. 

2. Select your school’s preferred letterforms 
before downloading the fonts.

5. Locate where the fonts have been downloaded  
on your PC to install.  
The fonts are named Letter-join Plus, Letter-join Air Plus, 

Letter-join No-lead, Letter-join Air No-lead and Letter-join Print, 

each followed by a number relating to your choice of letterforms.

6. Right-click the file and choose the ‘Install’ option.
Restart MS Word so that the font is recognised.  

The font is now ready to use in Microsoft Word and other 

applications that support Contextual Alternates.

Letter-join fonts can be distributed and installed onto classroom 

PCs and laptops across a school network. 

Please consult your IT technician to distribute the fonts using the 

MSI installer option from the link on the Letter-join ‘Download 

fonts’ page.

Access to Letter-join through LearnPad:

	 •	On your PC log in to LearnPad.

	 •	Log in to Class Connect.

	 •	Choose ‘Content’.

	 •	Search for keyword ‘Letterjoin’.

Setting up Letter-join for LearnPad

Issuing passwords to children for using Letter-join at 
school and home. 
Log in to Letter-join as ‘School Administrator’ and select ‘Home 
Instructions’ from the left hand menu. Open the link to the MS 
Word Document letter and insert Pupil log-in details where 
indicated. These can be found on your Letter-join Admin page.

The completed MS Word document can be printed onto 
a school letterhead or pasted into a school newsletter 
so children can use Letter-join at home.

The Letter-join Home Instructions letter

Naming your classes on the Admin page 
To allow pupils to access resources created by their class 
teacher, please see how to change class names on your 
Letter-join Admin page (see page 40 for details). 

Pupil log-in details 
Log-in details for pupils to log in to Letter-join at school and 
at home are listed on your school Letter-join Admin page.

There is a username and password to log in on PCs and and 
username and swipe code to log in on iPads and tablets.
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#letterjoin  
Follow us on Twitter!  

See inspiring school Letter-join 
handwriting examples on Twitter.

Download and print further copies  
of this manual at www.letterjoin.co.uk/manual.pdf


